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B9CREATE 1.0 TO FAST™ 

B9Create 2.0 TRANSITION 

 
This document is meant to transition users who are experienced in using the B9Create 1.0 

software to the FAST™ Technology Powered by B9Create 2.0. The goal is to explain where all the 

previous features of B9Create 1.0 are in FAST™ Technology Powered by B9Create 2.0 software & 

show how the workflow has changed. Note: This is done in Design Mode, not Workflow Mode. 
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UI (User Interface) Changes: 
 

1.0 UI: In B9Create 1.0, the printer connections, status, general data on the printers, and Print Editor are 

all located on the Printer Manager window. 

 

2.0 UI: In FAST™ Technology Powered by B9Create 2.0, the Print Editor is the main window and the Print 

Manager (Red) is now located in the drawer at the bottom left of the view window. General data 

and file transfer will be explained later in the document. 
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1.0 UI: In B9Create 1.0, the Perspective Snap Tools (Yellow) are across the top left of the view window. 

The model layout/support tabs (Green) are on the middle left of the view window.  

 

 

2.0 UI: In FAST™ Technology Powered by B9Create 2.0, the Perspective Snap Tools have moved to the 

bottom middle with an additional zoom-in/out slider. The layout/support tabs have moved to a drawer 

in the bottom right of the view window and can be accessed by clicking on that button in the bottom 

right corner of the view window (Red). 
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Importing Files:  
 

1.0 Importing Files: Clicking the Add button under the Model List will allow you to import STL files. 

 

2.0 Importing Files: In FAST™ Technology Powered by B9Create 2.0, once you’ve opened the Control 

Drawer (Red) the Add button (Yellow) is now on the right side of the view window, but still above 

the Model List. 
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2.0 Opening CPJX Files: Opening previously worked on or sliced CPJX files can be done by selecting the 

File tab and the Open button (Red) at the top left of the view window. Note: CPJX’s are not the same as 

CPJ files from B9Create 1.0. they are different slicing methods and CPJ’s are not compatible in the FAST™ 

Technology Powered by B9Create 2.0 software. Please see the method on how to use your CPJ layouts 

in FAST™ Technology Powered by B9Create 2.0 in the 2.0 and B9Create Desktop Manager document. 

 

 

 

1.0 STL Unit Menu to FAST™ Technology Powered by B9Create 2.0 Unit Selection Dropdown: The STL 

Unit pop-up window has been moved to a dropdown menu beside the Add button in FAST™ 

Technology Powered by B9Create 2.0 
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2.0 Import STL Repair Window: In FAST™ Technology Powered by B9Create 2.0, STL’s will go through an 

import window that has the file repaired, if necessary, and shows the user if the file size will slow 

down the software’s functionality. In this window you have the option to Add Files, Save Repaired 

Files, Import All, import models individually, or delete them from the Import Pending list. 

 

 

Layout/Orient Files:  
 

1.0 Selecting Printers, Slice Type, and Build Volume: In B9Create 1.0, you have the choice of slicing with 

Traditional or Surface Finish slicing options and you can select the Target Printer that you are 

making the CPJ file for. The Build Volume is then listed under these options. 

 

2.0 Selecting Printers, Materials, Slicing, and CPJX Information: In FAST™ Technology Powered by 

B9Create 2.0, all CPJX Files are sliced in the FAST slicing technique (Red) and you can select the 
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Printer Type (Yellow) from the dropdown menu. In the upper left corner of the view window 

(Green), there is the Project Name, Current Material Type, Height of the project, and the total 

Volume of the project. Note: The Material dropdown menu (Blue) is a new feature that allows you 

to alter the color of the project (post-slicing) and has a feature tied directly to auto supporting. 

Please see further explanation under the Supporting section and under the Part Template sub-

section. 

 

 

1.0 Model Layout and Orientation: In B9Create 1.0, the model manipulation tools are across the top 

middle of the view window (Red), the Duplicate and Remove buttons are above the Model List 

(Yellow), and the Model Information (Green) is under the Model List. The Snap to Floor button 

(Blue) is located above the Perspective Snap Tools. 
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2.0 Model Layout and Orientation: In FAST™ Technology Powered by B9Create 2.0, the model 

manipulation has been spread out over the UI. The Move, Spin, and Orient tools are now accessible 

through the Movement and Rotation Rings (Red). The Duplicate and Remove buttons (Yellow) are 

located beside the induvial models in the Model List. These can also be altered under the Position 

and Rotation sub-menu (Green). Note: Submerging models into the BT (Build Table) is now an 

optional function and can be activated by checking the box beside Allow negative Z (Purple). The 

Snap to Floor function (Blue) has been moved to a right click on the model you want to snap to the 

floor. 
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2.0 New Features within the Layout Tab: In FAST™ Technology Powered by B9Create 2.0, there are a 

variety of new features including the ones listed below. You can now name your STL files (Red), 

internally in the CPJX file, and select or create a new Part Template (Yellow). Please see further 

explanation under the New Features in Supporting your Models (Part Template Creation) subsection. 

You can also select new Supporting Guides that show what is being registered as supportable surface on 

your models and adjust the Horizontal and Vertical visualization of supported surfaces (Green). Note: 

The Auto Support Angle shows as a yellow highlight on the models and, when switched to the Support 

Tab, the Horizontal and Vertical adjustments show as a green highlight on the model after a support is 

placed. 

 

 

Supporting Files:  
 

1.0 Support Tab: In B9Create 1.0, supporting a model involved focusing on one model and going to a 

different “layer” of the software. Foundations, Supports, and Support Modifying were the main 
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functions of the Support Tab (Red). The tools to Add, Delete, and Modify supports (Yellow) are in the 

top middle of the viewing window. The X Ray Vision slider (Green) is above the entire view window. 

 

 

 

2.0 Support Tab: In FAST™ Technology Powered by B9Create 2.0, the Support Tab (Red) is still separate 

from the Layout Tab, but you are not focused on just one model; all models on the BT are visible. 

The ability to Add, Delete, and Modify supports looks differently and will be addressed later in this 

document. A new feature we have that is similar than the X Ray Vision Slider is the set of Sectioning 

Tool sliders (Green). These can be used to separate and split models in the X, Y, and Z axes. 
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1.0 Foundation Creation: In B9Create 1.0, you can add a foundation to your selected model by selecting 

the Foundation Check Box (Red). You can then alter the Shape, Coverage/Surface Area, and the 

Thickness (Yellow) of the foundation. 

 

 

 

 

 

2.0 Foundation Creation: In FAST™ Technology Powered by B9Create 2.0, you can add a foundation to 

your model(s) by selecting the Add Foundations (Red). To select a foundation preset, you can click 

on the Foundation Preset dropdown menu (Blue). To add a new Foundation Preset, you can click on 

the Add Foundation Preset Button (Purple). 
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2.0 After clicking on the Add Foundation Preset Button, you can Name the Preset and Save or Delete it 

(Green). You can also adjust the Bevel (distance between the foundation’s first layer and last layer), Rim 

Offset (distance between the model and the edge of the foundation), and the Thickness of the 

foundation. Note: The foundation in FAST™ Technology Powered by B9Create 2.0 is always a silhouette 

foundation type. 

 

 

 

 

1.0 Adding Supports: In B9Create 1.0, you have the Add tool (Red) selected and can click on the model, 

anywhere the Support Tip Indicator is highlighted green. 
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2.0 Adding Supports: In FAST™ Technology Powered by B9Create 2.0, you are always on the “Add” tool 

and can place supports anywhere in the allotted yellow highlighted Auto Support Angle. 

 

1.0 Modifying Supports: In B9Create 1.0, you either selected the support in the Support List (Red) or 

selected the Modify Tool (Red) and altered the anatomy of the support via the Support Parameters 
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menu (Yellow) at the bottom left of the view window. The Support Parameters menu allowed you to 

alter the Top, Mid, and Bottom of the supports. This menu also hosts the presets of Heavy, Medium, 

Light, and Tiny supports and allows for one temporary Custom slot. Note: Set Support Defaults, under 

the Settings Tab, is how to change the presets to something different than the default values. 

 

 

2.0 Modifying Supports: In FAST™ Technology Powered by B9Create 2.0, modifying the supports involves 

left clicking on the support you want to alter (Note: to select multiple supports, hold down the Ctrl key 

and left click on the other supports as needed) and a menu pops up, as shown below. You can save any 

preset you create using the Save as Preset button (Red). Note: For more information on Support Preset 

creation, see the Help Menu in the bottom left corner of the Support Tab. 

 



 
14 

1.0 Automatic Supports: In B9Create 1.0, the Auto Support tool (Red) is under the Support Tools tab at 

the top of the window. This tool brings up an Automatic Support tool pop-up menu that allows you to 

select the Support Density (Yellow) to generate. 

 

2.0 Auto Supporting: In FAST™ Technology Powered by B9Create 2.0, you have the option to choose 

Auto Supporting Configurations based on a previously made Part Template or to make a new Custom 

Configuration. To make a new configuration, you can select the Add Configuration button (Red) or select 

an existing configuration in the dropdown menu. You can alter the Auto Support Configuration and test 

it out on your models before saving and using the configuration in the future. Note: For more 

information on Auto Support Configuration, see the Help Menu in the bottom left corner of the Support 

Tab. 
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2.0 Auto Supporting: In FAST™ Technology Powered by B9Create 2.0, to auto support the model, you 

can right click on the model and a pop-up appears with the Auto Support Part option (Red). This also 

allows you to Add Reinforcement Bar (Note: See subsection New Features in Supporting your Models for 

more information on the Reinforcement Bar tool), Toggle Foundation, and Delete Part Supports.  

 

 

1.0 Making Supports Straight or Vertical: In B9Create 1.0, under the Support Parameters tab, there are 2 

buttons to alter a selected support named Make Vertical and Make Straight (Red). 

 

2.0 Making Supports Straight or Vertical: In FAST™ Technology Powered by B9Create 2.0, to make 

supports straight or vertical, you can right click on the support(s) that you want to alter and a pop-up 
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will appear with those tools (Red). This pop-up allows you to Make Support Angled, Delete Support, and 

Delete Selected Supports as well. Note: The Delete key on your keyboard can also be used to remove 

supports. 

 

 

2.0 New Features in Supporting your Models (Reinforcement Bar): In FAST™ Technology Powered by 

B9Create 2.0, there are some new features including the ability to place supportable Reinforcement 

Bars and Mirror Supports across the X, Y, and Z Planes of the model. To place a Reinforcement Bar, right 

click on the model, select the Add Reinforcement Bar option (Red), left click on the model for the Bar’s 

starting point, and then left click on the Bar’s ending point. Note: You can support the Reinforcement 

Bar and can right click on it and select Delete Reinforcement to remove the Bar. 
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2.0 New Features in Supporting your Models (Support Mirroring): In FAST™ Technology Powered by 

B9Create 2.0, you can mirror supports over a model’s axes in the X, Y, and Z. The Support Mirroring 

check boxes (Red) are in the top right corner of the window. 
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2.0 New Features in Supporting your Models (Part Template Creation): In FAST™ Technology Powered 

by B9Create 2.0, we have a tool called Part Template that is meant to create a template based on a set 

of similarly supported models using an auto support configuration, material selection, and other tools. 

The menu for Part Template Creation is accessible from the Layout Tab, clicking on the model, and 

selecting the Add Part Template button (Red). 
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Slicing Files:  
 

1.0 Slicing your Files: In B9Create 1.0, you can slice a file with Traditional or Surface Finish slicing options 

by selecting Slice… or the Slice for Surface Finish check box (Red). Note: Once sliced there is a Preview 

Slices button that allows you to cycle through the slices and check for errors in the file. 

 

2.0 Slicing your Files: In FAST™ Technology Powered by B9Create 2.0, all CPJX Files are sliced in the FAST 

slicing technique and can be sliced by selectin the Start Slicing button (Red) in the top right of the 

window of either the Layout or Support Tab. Note: Slices can be previewed after via the slider that 

appears in the top right corner of the window. 

 

 

Uploading Files:  
 

1.0 Uploading Files to Printers: In B9Create 1.0, you have 3 options to upload sliced prints to the printer. 

Upload directly from the replaced Slice… button in the Print Editor, upload to the printer from the Print 

Manager page, or upload to the printer via USB transfer. Note: Make sure to connect to the printers via 

their IP addresses prior to attempting WIFI transfers. 

2.0 Uploading Files to Printers: In FAST™ Technology Powered by B9Create 2.0, once the file has 

completed slicing, you can upload the file directly to the printer using the Printer Manager drawer (Red). 
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You can select the printer you are sending the file to by clicking on the Printer dropdown menu (Yellow). 

Note: The printer’s Queue can be located by clicking on the Queue tab (Green). 
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2.0 Data Management, Software Updates, and Printer Status:  
 

2.0 Data Management: In FAST™ Technology Powered by B9Create 2.0, there is a Dashboard (Red) 

located at the top right of the Printer Manager drawer that allows you to see all the data on previous 

prints completed on all connected printers. To save all the data, click on the Save button (Yellow) at the 

top right of the Dashboard. To see the data for the associated printer, click on the dropdown arrows 

(Green) to the left of the printer names. Use the vertical and horizontal scroll bars (Blue) to explore the 

data provided. 
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2.0 Printer Updates and Status: In FAST™ Technology Powered by B9Create 2.0, the printers can be 

updated by click on the Update Firmware buttons (Red) for the designated printers and their statuses 

(Yellow) are listed beside and below the printer’s name . 

 


